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artus® WNV TM RT-PCR Kit 

For use with the ABI PRISM® 7000, 7700 and 7900HT Sequence Detection 

Systems. 

For research use only. Not for use in diagnostic procedures. 

Attention: The artus WNV TM RT-PCR Kit may neither be used in 

combination with the GeneAmp® 5700 SDS nor with the 384 plate format of 

the ABI PRISM® 7900HT SDS. 

1. Contents 

 
Labelling 

and contents 
Art. No. 4509103 

24 reactions 
Art. No. 4509105 

96 reactions 

Blue WNV TM Master 2 x 12 rxns 8 x 12 rxns 

Yellow WNV TM Mg-Sol¤ 1 x 1,400 µl 1 x 1,400 µl 

Red WNV LC/TM QS 1¤ 
4 x 104 cop/µl 1 x 200 µl 1 x 200 µl 

Red WNV LC/TM QS 2¤ 
4 x 103 cop/µl 1 x 200 µl 1 x 200 µl 

Red WNV LC/TM QS 3¤ 
4 x 102 cop/µl 1 x 200 µl 1 x 200 µl 

Red WNV LC/TM QS 4¤ 
4 x 101 cop/µl 1 x 200 µl 1 x 200 µl 

Green WNV TM IC¤ 1 x 1,000 µl 2 x 1,000 µl 

White Water (PCR grade) 1 x 1,000 µl 1 x 1,000 µl 

¤ QS = Quantitation Standard 
 IC = Internal Control 
 Mg-Sol = Magnesium Solution 

 

2. Storage 

The components of the artus WNV TM RT-PCR Kit should be stored at -20°C 

and are stable until the expiry date stated on the label. Repeated thawing and 

freezing (> 2 x) should be avoided, as this may reduce the sensitivity. If the 

reagents are to be used only intermittently, they should be frozen in aliquots. 

Storage at +4°C should not exceed a period of five hours. 
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3. Additionally Required Materials and Devices 

� Disposable powder-free gloves 

� RNA isolation kit (see 8.1 RNA Isolation) 

� Pipettes (adjustable) 

� Sterile pipette tips with filters 

� Vortex mixer 

� Desktop centrifuge with rotor for 2 ml reaction tubes 

� Centrifuge with rotor for microtitre plates (optional) 

� 96-well reaction plate/reaction tubes for optical measurement with 

corresponding optical closing materials* (see 8.4 Preparing the PCR) 

� 96-well two-part retaining rack for use with optical reaction tubes 

(96-Well Tray/Retainer Set, Cat. No. 403 081, Applied Biosystems), 

see 8.4 Preparing the PCR  

� Compression pad for use with optical adhesive covers (Optical Cover 

Compression Pads, Cat. No. 4 312 639, Applied Biosystems), see 

8.4 Preparing the PCR  

� Applicator for sealing of the reaction plates using optical adhesive 

covers (Adhesive Seal Applicator Kit, Cat. No. 4 333 183, Applied 

Biosystems) 

� ABI PRISM® 7000, 7700 or 7900HT SDS 

Attention: A valid calibration of the pure dyes (Pure Spectra Component File) 

and the background (Background Component File) is necessary when putting 

the instruments into operation. 

                                                                  
* The use of reaction tubes for optical analyses with domed caps is only permitted with 

the ABI PRISM® 7700 SDS and requires an adjustment of the exposure time (see 
8.5.2 Programming the ABI PRISM® 7700 SDS, 8.5.2.5 Important Additional Settings). 
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4. General Precautions 

The user should always pay attention to the following: 

� Use sterile pipette tips with filters. 

� Store and extract positive material (specimens, controls and 

amplicons) separately from all other reagents and add it to the 

reaction mix in a spatially separated facility. 

� Thaw all components thoroughly at room temperature before starting 

an assay. 

� When thawed, mix the components and centrifuge briefly. 

� Work quickly on ice or in a cooling block. 

5. Pathogen Information 

West Nile virus (WNV) is a member of the family Flaviviridae (genus 

Flavivirus). Infected mosquitoes usually bite and infect wild birds - the primary 

host of the virus - but WNV can also infect humans and other mammals. 80 % 

of all infected humans do not present any WNV-related symptoms. WNV 

infections of elderly people, children and immunosuppressed patients may in 

rare cases result in fatal encephalitis or myocarditis. 

6. Principle of Real-Time PCR 

Pathogen detection by the polymerase chain reaction (PCR) is based on the 

amplification of specific regions of the pathogen genome. In real-time PCR the 

amplified product is detected via fluorescent dyes. These are usually linked to 

oligonucleotide probes which bind specifically to the amplified product. 

Monitoring the fluorescence intensities during the PCR run (i.e. in real-time) 

allows the detection and quantitation of the accumulating product without 

having to re-open the reaction tubes after the PCR run (Mackay, 2004). 
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7. Product Description 

The artus WNV TM RT-PCR Kit constitutes a ready-to-use system for the 

detection of WNV RNA using polymerase chain reaction (PCR) in the 

ABI PRISM® 7000, 7700 and 7900HT Sequence Detection System. The 

WNV TM Master contains reagents and enzymes for the reverse transcription 

and specific amplification of a 72 bp region of the WNV genome. The 

amplicon is detected by measuring the FAM fluorescence in the ABI PRISM® 

SDS. In addition, the atus WNV TM RT-PCR Kit contains a second 

heterologous amplification system to identify possible PCR inhibition. This is 

detected as an Internal Control (IC) by measuring the JOE fluorescence. The 

detection limit of the analytical WNV RT-PCR (see 11.1 Analytical 

Sensitivity) is not reduced. External positive controls (WNV LC/TM QS 1 - 4) 

are supplied which allow the determination of the pathogen load. For further 

information, please refer to section 8.3 Quantitation. 

8. Protocol 

8.1 RNA Isolation 

Various manufacturers offer RNA isolation kits. Sample amounts for the 

RNA isolation procedure depend on the protocol used. Please carry out the 

RNA isolation according to the manufacturer’s instructions. The following 

isolation kit is recommended: 

Sample 
Material 

Nucleic Acid 
Isolation Kit 

Catalogue 
Number Manufacturer Carrier RNA 

Plasma, CSF QIAamp Viral RNA 
Mini Kit (50) 52 904 QIAGEN included 

� The use of carrier RNA is critical for the extraction efficiency and, 

consequently, for DNA/RNA yield. To increase the stability of the carrier 

RNA provided with the QIAamp Viral RNA Mini Kit, we recommend the 

following procedure deviant from the user manual of the extraction kit: 
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a. Resuspend the lyophilised carrier RNA prior to first use of the 

extraction kit in 310 µl of the elution buffer provided with the kit (final 

concentration 1 µg/µl, do not use lysis buffer). Portion this carrier 

RNA solution into a number of aliquots adequate to your needs and 

store them at -20°C. Avoid repeated thawing (> 2 x) of a carrier RNA 

aliquot. 

b. Before the beginning of each extraction, a mixture of lysis buffer and 

carrier RNA (and Internal Control, where applicable, see 8.2 Internal 

Control) should be prepared freshly according to the following 

pipetting scheme: 

Number of samples 1 12 

Lysis buffer AVL 560 µl 6,720 µl 

Carrier RNA (1 µg/µl) 5.6 µl 67.2 µl 

Total Volume 565.6 µl 6,787.2 µl 

Volume per extraction 560 µl each 560 µl 

c. Please use the freshly prepared mixture of lysis buffer and carrier 

RNA instantly for extraction. Storage of the mixture is not possible. 

� When using isolation protocols with ethanol-containing washing buffers, 

please carry out an additional centrifugation step (three minutes, 

13,000 rpm) before the elution to remove any remaining ethanol. This 

prevents possible inhibition of PCR. 

� The artus WNV TM RT-PCR Kit should not be used with phenol-based 

isolation methods. 

Important: The Internal Control of the artus WNV TM RT-PCR Kit can be 

used directly in the isolation procedure (see 8.2 Internal Control). 
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8.2 Internal Control 

An Internal Control (WNV TM IC) is supplied. This allows the user both to 

control the RNA isolation procedure and to check for possible 

PCR inhibition (see Fig. 1). For this application, add the Internal Control to 

the isolation at a ratio of 0.1 µl per 1 µl elution volume. For example, using the 

QIAamp Viral RNA Mini Kit the RNA is eluted in 60 µl AVE buffer. Hence, 6 µl 

of the Internal Control should be added initially. If you elute e.g. in 50 µl, then 

use the corresponding volume of 5 µl. The quantity of Internal Control used 

depends only on the elution volume. The Internal Control and carrier RNA 

(see 8.1 RNA Isolation) should be added only 

� to the mixture of lysis buffer and sample material or 

� directly to the lysis buffer. 

The Internal Control must not be added to the sample material. If added to the 

lysis buffer, please note that the mixture of Internal Control and lysis 

buffer/carrier RNA has to be prepared freshly and used instantly (storage of 

the mixture at room temperature or in the fridge for only a few hours may lead 

to Internal Control failure and a reduced extraction efficiency). Please do not 

add the Internal Control and the carrier RNA to the sample material directly. 

The Internal Control can optionally be used exclusively to check for 

possible PCR inhibition (see Fig. 2). For this application, add 2 µl of the 

Internal Control and 12 µl WNV TM Mg-Sol per reaction directly to 18 µl 

WNV TM Master. For each PCR reaction use 30 µl of the Master Mix 

produced as described above* and add 20 µl of the purified sample. If you are 

preparing a PCR run for several samples please increase the volume of the 

WNV TM Master, the WNV TM Mg-Sol and the Internal Control according to 

the number of samples (see 8.4 Preparing the PCR). 

                                                                  
* The volume increase caused by adding the Internal Control is neglected when preparing 

the PCR assay. The sensitivity of the detection system is not impaired. 
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8.3 Quantitation 

The enclosed Quantitation Standards (WNV LC/TM QS 1 - 4) are treated as 

previously purified samples and the same volume is used (20 µl). To generate 

a standard curve on an ABI PRISM® Sequence Detection System, all four 

Quantitation Standards should be used and defined as standards with 

specification of the corresponding concentrations (see 8.5 Programming the 

ABI PRISM® SDS). The import of standard curves from previous runs is not 

possible with the ABI PRISM® 7000, 7700 and 7900HT SDS software. 

Attention: The Quantitation Standards are defined as copies/µl. The following 

equation has to be applied to convert the values determined using the 

standard curve into copies/ml of sample material: 

Result (copies/µl) x Elution Volume (µl) 
Result (copies/ml) = 

Sample Volume (ml)  

Please note that as a matter of principle the initial sample volume should be 

entered in the equation above. This has to be considered when the sample 

volume has been changed prior to the nucleic acid extraction (e.g. narrowing 

the volume by centrifugation or increase of volume by replenishment to the 

volume required for the isolation). 

Important: A guideline for the quantitative analysis of artus systems on the 

ABI PRISM® 7000 SDS is provided at 

www.qiagen.com/Products/ByLabFocus/MDX (Technical Note for 

quantitation on the ABI PRISM® 7000 SDS). 
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8.4 Preparing the PCR 

Prepare the number of required reaction tubes or a 96-well reaction plate for 

the scheduled reactions. Recommended materials are listed in the following 

table: 

Article Description Catalogue 
Number Manufacturer Retaining 

Rack* 
Compression 

Pad 

96-well 
optical 

reaction 
plate 

96-Well Optical 
Reaction Plate 4 306 737 Applied 

Biosystems no - 

Optical 
adhesive 
covers 

Optical 
Adhesive 
Covers 

4 311 971 Applied 
Biosystems - yes 

Optical 
reaction 

tubes 

ABI PRISM® 
Optical Tubes, 
8 Tubes/Strip 

4 316 567 Applied 
Biosystems yes - 

Optical 
reaction 

tubes 

MicroAmp® 
Optical Tubes N8010933 Applied 

Biosystems yes - 

Optical 
caps 
(flat) 

ABI PRISM® 
Optical Caps, 
8 Caps/Strip 

4 323 032 Applied 
Biosystems - no 

Attention: The use of reaction tubes for optical analyses with domed caps is 

only permitted with the ABI PRISM® 7700 SDS and requires an adjustment of 

the exposure time (see 8.5.2 Programming the ABI PRISM® 7700 SDS, 

8.5.2.5 Important Additional Settings). 

When preparing the PCR reaction, please make sure that at least one 

Quantitation Standard per PCR run as well as one negative control (Water, 

PCR grade) are performed in parallel. To generate a standard curve, use all 

supplied Quantitation Standards (WNV LC/TM QS 1 - 4) for each PCR run. 

Before each use, all reagents need to be thawed completely, mixed (by 

repeated up and down pipetting or by inverting the tube several times) and 

centrifuged briefly. 

                                                                  
* If the two-part retaining rack is used, it is necessary to open the reaction tubes when 

inserting them into and removing them from the rack. In order to avoid contamination 
due to this procedure, please use the lower part of the retaining rack only. 
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If you want to use the Internal Control to monitor the RNA isolation 

procedure and to check for possible PCR inhibition, it has already been 

added to the isolation (see 8.2 Internal Control). In this case, please use the 

following pipetting scheme (for a schematic overview see Fig. 1): 

 Number of samples 1 12 

WNV TM Master 18 µl 216 µl 

WNV TM Mg-Sol 12 µl 144 µl 

WNV TM IC 0 µl 0 µl 

1. Preparation of 

Master Mix 

Total Volume 30 µl 360 µl 

Master Mix 30 µl 30 µl each 

Sample 20 µl 20 µl each 
2. Preparation of 

PCR assay 
Total Volume 50 µl 50 µl each 

If you want to use the Internal Control exclusively to check for 

PCR inhibition, it must be added directly to the WNV TM Master. In this case, 

please use the following pipetting scheme (for a schematic overview see 

Fig. 2): 

 Number of samples 1 12 

WNV TM Master 18 µl 216 µl 

WNV TM Mg-Sol 12 µl 144 µl 

WNV TM IC 2 µl 24 µl 

1. Preparation of 

Master Mix 

Total Volume 32 µl* 384 µl* 

Master Mix 30 µl* 30 µl each* 

Sample 20 µl 20 µl each 
2. Preparation of 

PCR assay 
Total Volume 50 µl 50 µl each 

Pipette 30 µl of the Master Mix into each required reaction tube or well of the 

96-well reaction plate. Subsequently add 20 µl of the eluate from the 

RNA isolation. Mix the solution well by repeated up and down pipetting. Close 

the reaction tubes with the corresponding caps or, alternatively, when using a 

96-well reaction plate, with optical adhesive covers (Optical Adhesive Covers). 

Centrifuge the reaction tubes (in a storage rack for PCR tubes) or the 96-well 

                                                                  
* The volume increase caused by adding the Internal Control is neglected when preparing 

the PCR assay. The sensitivity of the detection system is not impaired. 
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reaction plate in a centrifuge with a microtitre plate rotor for 30 seconds at 

1,780 x g (4,000 rpm) in order to collect the prepared reaction volume in the 

bottom of the tube or well. If such a centrifuge is not at your disposal, please 

make sure that both the Master Mix and the sample volume are pipetted to the 

bottom of the tubes or wells. Store the prepared reactions at +4°C until the 

ABI PRISM® SDS Instrument is programmed (see 8.5 Programming the 

ABI PRISM® SDS) and subsequently transfer them into the instrument. 

Attention: 

� When using optical reaction tubes in combination with optical caps, 

always insert a retaining rack (96-Well Tray/Retainer Set) into the 

instrument (ABI PRISM® 7000, 7700 and 7900HT SDS). If the two-part 

retaining rack is used, it is necessary to open the reaction tubes when 

inserting them into and removing them from the rack. In order to avoid 

contamination due to this procedure, please use the lower part of the 

retaining rack only. 

� Using 96-well optical reaction plates in combination with optical adhesive 

covers requires covering by a compression pad (Optical Cover 

Compression Pads). 
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Addition of the Internal Control to the Purification Procedure 
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Fig. 1: Schematic workflow for the control of both the purification 
procedure and PCR inhibition. 

*
Please make sure that the solutions are thawed completely, 
mixed well and centrifuged briefly. 
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Addition of the Internal Control into the artus Master 

12 µl       
Mg-Sol*

Purification

20 µl Purified Sample* 30 µl Master Mix*

Optical Reaction      
Plate / Tube

ABI PRISM® SDS

18 µl artus 
Master*

32 µl Master Mix*

2 µl IC*

 

Fig. 2: Schematic workflow for the control of PCR inhibition. 

*
Please make sure that the solutions are thawed completely, 
mixed well and centrifuged briefly. 
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8.5 Programming the ABI PRISM® SDS 

The software of the ABI PRISM® 7000, 7700 and 7900HT Sequence Detection 

Systems (SDS) requires some additional information before starting the PCR 

run. The programming procedures of the instruments, however, differ 

considerably from each other, which is why they are treated in separate 

chapters as follows. 

8.5.1 Programming the ABI PRISM® 7000 SDS 

For the detection of WNV RNA, create a profile on your ABI PRISM® 7000 

SDS according to the following six steps (8.5.1.1 - 8.5.1.6). All specifications 

refer to the ABI PRISM® 7000 SDS software version 1.0.1. For programming 

details of the ABI PRISM® 7000 SDS, please refer to the ABI PRISM® 7000 

SDS User Guide. For a better overview, the software settings are framed in 

bold black. 

8.5.1.1 Pre-Settings for Creating a New PCR Run 

Select the item New from the File menu on the ABI PRISM® 7000 SDS and 

programme the following initial settings for the new document (see Fig. 3). A 

backup template (SDS Template [*.sdt]) is available from the Template list or 

by selection using the Browse function (see 8.5.1.5 Saving the PCR Run). 

Confirm your pre-settings (OK). 

 

Fig. 3: Pre-settings for creating a new PCR run (New Document). 
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8.5.1.2 Creating/Selecting the Detectors 

With the help of the submenu Detector Manager from the Tools menu, assign 

the corresponding detector dyes to the file. For the detection of WNV RNA as 

well as the Internal Control by means of the artus WNV TM RT-PCR Kit, the 

reporters/quenchers listed in the following table are to be defined: 

Detection Reporter Quencher 

WNV RNA FAM none 

Internal Control (WNV TM IC) JOE none 

To create these detectors, select the option File (bottom left of the Detector 

Manager) and subsequently the option New. 

  

Fig. 4: Creating the WNV specific 
detector (Detector Manager). 

Fig. 5: Creating the IC specific detector 
(Detector Manager). 

For the detection of WNV RNA define the reporter/quencher combination 

FAM/none in the new window. For the detection of the Internal Control, select 

the combination JOE/none (as shown in Fig. 4 and Fig. 5). By confirming the 

input data (OK), return to the Detector Manager. Mark the newly created 

detectors and transfer each selection to the Well Inspector by clicking on the 

option Add to Plate Document (see Fig. 6). Close the window (Done). 



 
 

artus WNV TM RT-PCR Kit   06/2007 19 

 

Fig. 6: Selecting the detectors (Detector Manager). 

8.5.1.3 Assigning the Necessary Information to the Plate Positions 

Open Well Inspector from the View menu to find the detectors selected under 

8.5.1.2 (see Fig. 7). 

 

Fig. 7: Assigning the necessary information to the plate positions (Well Inspector). 

Mark the plate positions reserved for the detection of WNV RNA. Assign the 

selected detectors to these positions by activating the Use option of both 

detectors, upon which a tick will appear. For the denomination of each single 

reaction, select the corresponding position on the plate and enter the name 

(Sample Name). Please note that preparations with an identical Sample Name 

and an identical detector assignment will be identified as replicates by the 

software and will be averaged with respect to the quantified pathogen load. 
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Then select the corresponding function (Task) for each sample type according 

to the following table: 

Sample Type Function 
(Task) 

Concentration 
(Quantity) Reporter Quencher 

Sample Unknown - FAM none 

Non-template 
control NTC - FAM none 

Standard Standard see 1. Contents FAM none 

To generate a standard curve, use all supplied Quantitation Standards 

(WNV LC/TM QS 1 - 4) per PCR run and enter the corresponding 

concentrations (see 1. Contents) for each standard (Quantity). Please note 

that for a PCR run with the artus WNV TM RT-PCR Kit, ROX has to be set as 

a passive reference (Passive Reference). The equal distribution of the ROX 

dye in all PCR preparations of a lot by mixing of the WNV TM Master 

guarantees the recognition and calculation of tube-to-tube variations 

(fluorescence differences between several PCR preparations) by means of the 

Sequence Detection Software (normalization). 

8.5.1.4 Creating the Temperature Profile 

To create a temperature profile, switch from the Setup level to the Instrument 

level in the software. Enter the temperature profile specific for the detection of 

WNV RNA according to Fig. 8. Make sure that the reaction volume is set to 

50 µl. The option 9600 Emulation should be activated, the pre-settings of the 

Auto Increment should remain unchanged (Auto Increment: 0.0°C, 

0.0 Seconds). 
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Fig. 8: Creating the temperature profile. 

8.5.1.5 Saving the PCR Run 

Save the settings (Setup) as a template in order to make use of them again 

later in a modified or unchanged form. By saving the settings as a SDS 

Template (*.sdt) in the Template Directory (Local Disk 

[C:]\Program Files\ABI PRISM 7000\Templates, created by Applied 

Biosystems), this file may be selected directly in the New Document window 

from the Template drop-down list. Copies stored in other folders have to be 

opened via Browse. Before starting the PCR run, save it again as a SDS 

Document (*.sds), in order to guarantee the saving of the data that will be 

collected during the course of the PCR. 

8.5.1.6 Starting the PCR Run 

Start the PCR run by selecting the option Start from the menu item Instrument 

or the field Start on the Instrument level. 
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8.5.2 Programming the ABI PRISM® 7700 SDS 

For the detection of WNV RNA, create a profile on your ABI PRISM® 7700 

SDS according to the following seven steps (8.5.2.1 - 8.5.2.7). All 

specifications refer to the ABI PRISM® 7700 SDS software version 1.9.1. For 

programming details of the ABI PRISM® 7700 SDS, please refer to the 

ABI PRISM® 7700 SDS User`s Manual. For a better overview, the software 

settings are framed in bold black. 

8.5.2.1 Pre-settings for Creating a New PCR Run 

Select the item New Plate from the File menu on the ABI PRISM® 7700 SDS 

and programme the following initial settings for the new document (see Fig. 9). 

Confirm the pre-settings (OK). 

 

Fig. 9: Pre-settings for creating a new PCR run (New Plate). 

8.5.2.2 Selecting the Fluorescence Dyes and Assigning the Sample 

Type 

With the help of the Sample Type Setup (Setup level: Sample Type/Sample 

Type Setup) assign the corresponding detector dyes and the corresponding 

sample type to the file. For the detection of WNV RNA as well as the Internal 

Control by means of the artus WNV TM RT-PCR Kit, the reporters/quenchers 

listed in the following table are to be defined: 
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Detection Reporter Quencher 

WNV RNA FAM none 

Internal Control (WNV TM IC) JOE none 

For the analysis of WNV RNA by means of the artus WNV TM RT-PCR Kit, 

select the reporter dye FAM as given in the table. This applies to standards 

(STND) and samples (UNKN) as well as to non-template controls (UNKN). For 

the analysis of the Internal Control (IPC+), define JOE as reporter. As 

quencher set none. The assignment of the dyes and sample types in the 

window Sample Type Setup is shown in Fig. 10. 

 

Fig. 10: Selecting the fluorescence dyes and assigning the sample type 
(Sample Type Setup). 

Please assign the sample type to a corresponding function (Acronym) 

according to the following table: 

Sample Type Function 
(Acronym) 

Concentration 
(Quantity) Reporter Quencher 

Sample UNKN - FAM none 

Non-template 
control UNKN - FAM none 

Standard STND see 1. Contents FAM none 

 



24 artus WNV TM RT-PCR Kit   06/2007 

8.5.2.3 Assigning the Necessary Information to the Plate Positions 

For the assignment of the detectors and sample types to the individual plate 

positions, select the corresponding fields. Then open the dialogue window 

Dye Layer on the Setup level and assign the corresponding reporter. Upon 

activation of the pop-up menu Sample Type, you will find the sample types 

assigned to the reporter in the Sample Type Setup in the appearing list 

(see Fig. 11). Select the adequate sample type (see Table under 8.5.2.2) and 

assign the remaining plate positions by means of the Dye Layers and the 

Sample Type menu. A name may be assigned to each sample in the field 

Sample Name. Fields defined as Replicates (entering of the name of the 

reference sample into the Replicate column) are averaged by the software 

with respect to the quantified pathogen load and the standard deviation will be 

calculated. 

  

Fig. 11/12: Assigning the necessary information to the plate positions. 

To generate a standard curve, use all supplied Quantitation Standards 

(WNV LC/TM QS 1 - 4) per PCR run and enter the corresponding 

concentrations (see 1. Contents) for each standard into the field Quantity 

(see Fig. 12). This is only possible, however, if the positions reserved for 

standards were defined as such before by means of the Sample Type menu. 

8.5.2.4 Creating the Temperature Profile 

To create a temperature profile, switch to the Thermal Cycler Conditions menu 

on the Setup level. Enter the temperature profile specific for the detection of 

WNV RNA according to Fig. 13. Make sure that the reaction volume is set to 
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50 µl. The pre-settings of the Ramp times and of the Auto Increment remain 

unchanged (Ramp Time: 0:00, Auto Increment: 0.0°C, 0.0 Seconds). 

 

Fig. 13: Creating the temperature profile. 

In addition, the Thermal Cycler Conditions menu contains the option Show 

Data Collection. By selecting this option the window depicted in Fig. 14 is 

opened. Each ramp and each plateau temperature shows a Data Collection 

Icon, which illustrates the data being collected at this stage of the run. 

Remove all symbols except the one for the Annealing-Extension step 

(Stage3/Step2) in order to exclude unnecessary fluorescence measurements. 

The total run time and the data quantity will thus be kept at a minimum. 
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Fig. 14: Data collection. 

8.5.2.5 Important Additional Settings 

For the setting of the exposure time (excitation of the fluorescence dyes) as 

well as for the selection of the Pure Spectra/Background  files, switch from the 

Setup level to the Analysis level. Select the activated sub-item Advanced 

Options to be found in the Instrument menu under Diagnostics. Adjust the 

settings according to Fig. 15. By inactivating the optional function Spectra 

Components (Analysis) the actual calibration files stored in the file Spectra 

Components at the moment of data generation are automatically used when 

re-evaluating already analysed runs. For an analysis of previous runs by using 

newly entered Spectra Components, activate these two fields. Please note 

that for a PCR run with the artus WNV TM RT-PCR Kit, ROX has to be set as 

a passive reference (Reference). The equal distribution of the ROX dye in all 

PCR preparations of a lot by mixing of the WNV TM Master guarantees the 

recognition and calculation of tube-to-tube variations (fluorescence differences 

between several PCR preparations) by means of the Sequence Detection 

Software (normalization). 
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Attention: When using 96-well reaction plates for optical measurements in 

combination with optical adhesive covers or optical reaction tubes with flat 

caps, the exposure time is ten milliseconds. If you use optical reaction tubes 

with domed caps, you have to adjust this exposure time to 25 milliseconds. 

 

Fig. 15: Important additional settings (Advanced Options). 

8.5.2.6 Saving the PCR Run 

Save the settings (Setup) as a template in order to make use of them again 

later in a modified or unchanged form. For this purpose store the file in the 

Stationary File Format. Before starting a newly programmed PCR run, please 

save it again in the Normal File Format in order to guarantee the saving of 

data that will be collected during the course of the PCR. 
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8.5.2.7 Starting the PCR Run 

Start the PCR run by selecting the option Run from the menu item Instrument 

or the field Run on the Analysis level. 
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8.5.3 Programming the ABI PRISM® 7900HT SDS 

For the detection of WNV RNA, create a profile on your ABI PRISM® 7900HT 

SDS according to the following six steps (8.5.3.1 - 8.5.3.6). All specifications 

refer to the ABI PRISM® 7900HT SDS software version 2.1. For programming 

details of the ABI PRISM® 7900HT SDS, please refer to the ABI PRISM® 

7900HT SDS User Guide. For a better overview, the software settings are 

framed in bold black. 

8.5.3.1 Pre-Settings for Creating a New PCR Run 

Select the item New from the File menu on the ABI PRISM® 7900HT SDS and 

programme the following initial settings for the new document (see Fig. 16). A 

backup template (ABI PRISM® SDS Template Document [*.sdt]) is available 

from the Template list or by selection using the Browse function (see 

8.5.3.5 Saving the PCR Run). Confirm the pre-settings (OK). 

Attention: The artus WNV TM RT-PCR Kit may not be used in combination 

with the 384 plate format of the ABI PRISM® 7900HT SDS. 

 

Fig. 16: Pre-settings for creating a new PCR run (New Document). 
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8.5.3.2 Creating/Selecting the Detectors 

With the help of the submenu Detector Manager from the Tools menu 

(alternatively: Setup level/Add Detector select function), assign the 

corresponding detector dyes to the file. For the detection of WNV RNA as well 

as the Internal Control by means of the artus WNV TM RT-PCR Kit, the 

reporters/quenchers listed in the following table are to be defined: 

Detection Reporter Quencher 

WNV RNA FAM TAMRA 

Internal Control (WNV TM IC) JOE Non fluorescent 

To create these detectors, select the option New (bottom left of the Detector 

Manager). 

  

Fig. 17: Creating the WNV specific 
detector (Detector Manager). 

Fig. 18: Creating the IC specific detector 
(Detector Manager). 

For the detection of WNV RNA define the reporter/quencher combination 

FAM/TAMRA in the new window*. For the detection of the Internal Control, 

select the combination JOE/Non fluorescent (as shown in Fig. 17 and 

Fig. 18). By confirming the input data (OK), return to the Detector Manager. 

Mark the newly created detectors and transfer each selection to the Setup 

                                                                  
* Please note: Use the reporter/quencher combination FAM/TAMRA for the ABI PRISM® 

7900HT SDS only. 
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level by clicking on the option Copy to Plate Document (see Fig. 19). Close 

the window (Done). 

 

Fig. 19: Selecting the detectors (Detector Manager). 

8.5.3.3 Assigning the Necessary Information to the Plate Positions 

After having closed the Detector Manager (Done) the detectors selected under 

8.5.3.2 are found on the Setup level listed in a table (see Fig. 20). 

 

Fig. 20: Assigning the necessary information to the plate positions. 

Mark the plate positions reserved for the detection of WNV RNA. Assign the 

selected detectors to these positions by activating the Use option of both 

detectors, upon which a cross will appear. For the denomination of each 

single reaction, select the corresponding position on the plate and enter the 

name (Sample Name). Please note that preparations with an identical Sample 

Name and an identical detector assignment will be identified as replicates by 

the software and will be averaged with respect to the quantified pathogen 
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load. Then select the corresponding function (Task) for each sample type 

according to the following table: 

Sample Type Function 
(Task) 

Concentration 
(Quantity) Reporter Quencher 

Sample Unknown - FAM TAMRA 

Non-template 
control NTC - FAM TAMRA 

Standard Standard see 1. Contents FAM TAMRA 

To generate a standard curve, use all supplied Quantitation Standards 

(WNV LC/TM QS 1 - 4) per PCR run and enter the corresponding 

concentrations (see 1. Contents) for each standard (Quantity). Please note 

that for a PCR run with the artus WNV TM RT-PCR Kit, ROX has to be set as 

a passive reference (Passive Reference). The equal distribution of the ROX 

dye in all PCR preparations of a lot by mixing of the WNV TM Master 

guarantees the recognition and calculation of tube-to-tube variations 

(fluorescence differences between several PCR preparations) by means of the 

Sequence Detection Software (normalization). 

8.5.3.4 Creating the Temperature Profile 

To create a temperature profile, switch from the Setup level to the Instrument 

level in the software. Enter the valid temperature profile for the detection of 

WNV RNA according to Fig. 21. Make sure that the reaction volume is set to 

50 µl. The option 9600 Emulation should be activated, the pre-settings of the 

Ramp time and the Auto Increment should remain unchanged 

(Ramp Time: 0:00, Auto Increment: 0.0°C, 0.0 Seconds). 
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Fig. 21: Creating the temperature profile. 

In addition, the Instrument level contains the option Data Collection. By 

selecting this option the window depicted in Fig. 22 is opened. Each ramp and 

each plateau temperature shows a Data Collection Icon, which illustrates the 

data being collected at this stage of the run. Remove all symbols except the 

one for the Annealing-Extension step (Stage3/Step2) by clicking on them in 

order to exclude unnecessary fluorescence measurements. The total run time 

and the data quantity will thus be kept at a minimum. 
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Fig. 22: Data collection. 

8.5.3.5 Saving the PCR Run 

Save the settings (Setup) as a template in order to make use of them again 

later in a modified or unchanged form. By saving the settings as an 

ABI PRISM® SDS Template Document (*.sdt) in the Template Directory 

([D:]\Program Files\Applied Biosystems\SDS 2.1\Templates, created by 

Applied Biosystems), this file may be selected directly in the New Document 

window from the Template list. Copies stored in other folders have to be 

opened via Browse. Before starting the PCR run, save it again as an 

ABI PRISM® SDS Document (*.sds) in order to guarantee the saving of the 

data that will be collected during the course of the PCR. 

8.5.3.6 Starting the PCR Run 

Start the PCR run by selecting the option Start from the menu item Instrument. 
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9. Data Analysis 

A valid calibration of the dyes (Pure Spectra Component File) and the 

background (Background Component File) is necessary when putting the 

instruments into operation. These calibration files are required for the exact 

calculation of the results as follows: 

All interfering signals generated by the instruments which influence the 

measurement are eliminated by the Sequence Detection Software of the 

ABI PRISM® Sequence Detection Systems by means of the Background 

Component File. 

Furthermore, interferences appear during multicolour analyses between the 

emission spectra of the single fluorescence dyes. The software of the 

ABI PRISM® SDS compensates these interferences by calculations using the 

spectrum data of the individual dyes stored in the Pure Spectra Component 

File. The software uses the same file for the assignment of the fluorescence 

data comprising the entire measurable spectrum collected in the course of the 

PCR to the programmed detectors. The fluorescence data of the individual 

dyes are subsequently divided by the value obtained for the signal of the 

passive reference (ROX) in order to account for tube-to-tube variations 

(fluorescence differences between several PCR preparations). The thus 

normalized signals may then be evaluated by means of the Amplification Plot. 

The calibration files used for the evaluation of a PCR run are automatically 

stored with the saving of the run. If no calibration files are installed, please 

create these files according to the instructions given in the ABI PRISM® SDS 

User Guide/Manual. 

If more than one artus TM PCR system is integrated in your PCR run (note 

temperature profile), these assays should be analysed separately. Samples 

with an identical Sample Name and an identical detector assignment will 

automatically be identified as replicates by the ABI PRISM® 7000 and 7900HT 

SDS Software and will be averaged with respect to the quantified pathogen 

load. 
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The following results are possible: 

1. A FAM fluorescence signal is detected. 

The result of the analysis is positive: The sample contains 

WNV RNA. 

In this case, the detection of a JOE fluorescence signal (Internal Control) is 

dispensable, since high initial concentrations of WNV RNA (positive FAM 

fluorescence signal) can lead to a reduced or absent fluorescence signal of the 

Internal Control (competition). 

2. No FAM fluorescence signal is detected. At the same time, a JOE 

fluorescence signal from the Internal Control appears. 

In the sample no WNV RNA is detectable. It can be considered 

negative. 

In the case of a negative WNV RT-PCR the detected signal of the Internal Control 

rules out the possibility of RT-PCR inhibition. 

3. Neither a FAM fluorescence signal nor a JOE fluorescence signal is 

detected. 

No result can be concluded. 

Information regarding error sources and their solution can be found in 

10. Troubleshooting. 

Examples of positive and negative PCR reactions are given in Fig. 23 / 24 

(ABI PRISM® 7000 SDS), 25 / 26 (ABI PRISM® 7700 SDS) and 27 / 28 

(ABI PRISM® 7900HT SDS). 



 
 

artus WNV TM RT-PCR Kit   06/2007 37 

 

Fig. 23: Detection of the Quantitation Standards (WNV LC/TM 
QS 1 - 4) by measurement of the FAM fluorescence signal 
(ABI PRISM® 7000 SDS). NTC: non-template control 
(negative control). 

 

Fig. 24: Detection of the Internal Control (IC) by measurement of the 
JOE fluorescence signal (ABI PRISM® 7000 SDS) with 
simultaneous amplification of the Quantitation Standards 
(WNV LC/TM QS 1 - 4). NTC: non-template control (negative 
control). 
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Fig. 25: Detection of the Quantitation Standards (WNV LC/TM 
QS 1 - 4) by measurement of the FAM fluorescence signal 
(ABI PRISM® 7700 SDS). NTC: non-template control 
(negative control). 

 

Fig. 26: Detection of the Internal Control (IC) by measurement of the 
JOE fluorescence signal (ABI PRISM® 7700 SDS) with 
simultaneous amplification of the Quantitation Standards 
(WNV LC/TM QS 1 - 4). NTC: non-template control (negative 
control). 
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Fig. 27: Detection of the Quantitation Standards (WNV LC/TM 
QS 1 - 4) by measurement of the FAM fluorescence signal 
(ABI PRISM® 7900HT SDS). NTC: non-template control 
(negative control). 

 

Fig. 28: Detection of the Internal Control (IC) by measurement of the 
JOE fluorescence signal (ABI PRISM® 7900HT SDS) with 
simultaneous amplification of the Quantitation Standards 
(WNV LC/TM QS 1 - 4). NTC: non-template control (negative 
control). 
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10. Troubleshooting 

No FAM fluorescence signal with positive controls (WNV LC/TM 

QS 1 - 4): 

� The selected detection dye for PCR data analysis does not comply with 

the protocol. 

� For data analysis select the detection dye FAM for the analytical 

WNV RT-PCR and the detection dye JOE for the Internal Control 

RT-PCR.  

� The settings used for the data analysis under Options (Extension Phase 

Data Extraction) do not correspond to the settings of the Data Collection 

(for ABI PRISM® 7700 SDS see 8.5.2.4 Creating the Temperature 

Profile, for ABI PRISM® 7900HT SDS see 8.5.3.4 Creating the 

Temperature Profile). 

� Analyse the PCR run with corrected settings and repeat the data 

analysis (Analysis). 

� Incorrect programming of the temperature profile of the ABI PRISM® 

Sequence Detection System. 

� Compare the temperature profile with the protocol (see 

8.5 Programming the ABI PRISM® SDS). 

� Incorrect configuration of the PCR reaction. 

� Check your work steps by means of the pipetting scheme (see 

8.4 Preparing the PCR) and repeat the PCR, if necessary. 

� The storage conditions for one or more kit components did not comply 

with the instructions given in 2. Storage or the artus WNV TM RT-PCR Kit 

had expired. 

� Please check the storage conditions and the expiration date (see the 

kit label) of the reagents and use a new kit, if necessary.  
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Weak or no signal of the Internal Control (JOE fluorescence signal) and 

simultaneous absence of a FAM fluorescence signal for the specific 

WNV RT-PCR: 

� The PCR conditions do not comply with the protocol. 

� Check the PCR conditions (see above) and repeat the PCR with 

corrected settings, if necessary. 

� The PCR was inhibited. 

� Make sure that you use a recommended isolation method 

(see 8.1 RNA Isolation) and stick closely to the manufacturer’s 

instructions. 

� Make sure that during the RNA isolation the recommended additional 

centrifugation step has been carried out before the elution in order to 

remove any residual ethanol (see 8.1 RNA Isolation). 

� RNA was lost during extraction. 

� If the Internal Control had been added to the extraction, an absent 

signal of the Internal Control can indicate the loss of RNA during the 

extraction. Make sure that you use a recommended isolation method 

(see 8.1 RNA Isolation) and stick closely to the manufacturer’s 

instructions. 

� The storage conditions for one or more kit components did not comply 

with the instructions given in 2. Storage or the artus WNV TM RT-PCR Kit 

had expired. 

� Please check the storage conditions and the expiration date (see the 

kit label) of the reagents and use a new kit, if necessary.  

A FAM fluorescence signal of the analytical RT-PCR with the negative 

controls: 

� A contamination occurred during preparation of the PCR. 

� Repeat the PCR with new reagents in replicates. 

� If possible, close the PCR tubes directly after addition of the sample to 

be tested. 

� Strictly pipette the positive controls at last. 

� Make sure that work space and instruments are decontaminated at 

regular intervals. 
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� A contamination occurred during extraction. 

� Repeat the extraction and PCR of the sample to be tested using new 

reagents.  

� Make sure that work space and instruments are decontaminated at 

regular intervals. 

If you have any further questions or if you encounter problems, please contact 

our Technical Service. 

11. Specifications 

11.1 Analytical Sensitivity 

In order to determine the analytical sensitivity of the artus WNV TM RT-

PCR Kit, a dilution series has been set up from 40 to nominal 0.004 of 

extracted and prequantified WNV RNA copies per µl and analysed by means 

of the ABI PRISM® 7000, 7700 and 7900HT Sequence Detection Systems 

with the help of the artus WNV TM RT-PCR Kit. Testing for all instruments 

was carried out on three different days on eight replicates. The results were 

determined by a probit analysis. A graphical illustration of the probit analysis 

(ABI PRISM® 7900HT SDS) is shown in Fig. 29. 

Detection limit (p = 0.05) 

ABI PRISM® 7000 SDS 0.3 copies/µl 

ABI PRISM® 7700 SDS 0.3 copies/µl 

ABI PRISM® 7900HT SDS 0.6 copies/µl 

This means that there is a 95 % probability that 0.3 copies/µl (ABI PRISM® 

7000 SDS), 0.3 copies/µl (ABI PRISM® 7700 SDS) and 0.6 copies/µl 

(ABI PRISM® 7900HT SDS) will be detected. 
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Probit analysis: West Nile virus (ABI PRISM® 7900HT SDS) 

 
Fig. 29: Analytical sensitivity of the artus WNV TM RT-PCR Kit 

(ABI PRISM® 7900HT SDS). 

11.2 Specificity 

The specificity of the artus WNV TM RT-PCR Kit is first and foremost ensured 

by the selection of the primers and probes, as well as the selection of stringent 

reaction conditions. The primers and probes were checked for possible 

homologies to all in gene banks published sequences by sequence 

comparison analysis. The detectability of all relevant WNV strains has thus 

been ensured. 

Moreover, the specificity was validated with 30 different WNV negative liquor 

and plasma samples. These did not generate any signals with the WNV 

specific primers and probes, which are included in the WNV TM Master. 

To determine the specificity of the artus WNV TM RT-PCR Kit the control 

group listed in the following table (see Table 1) has been tested for 

cross-reactivity. None of the tested pathogens has been reactive. 
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Table 1: Testing the specificity of the kit with potentially cross-reactive pathogens. 

Control group WNV 
(FAM) 

Internal 
Control 
(JOE) 

Dengue virus 1 - 4 - + 

Japanese encephalitis virus - + 

Yellow fever virus - + 

Montana myotis Leucoencephalitis virus - + 

Modoc virus - + 

Human immunodeficiency virus 1 - + 

Coxackievirus B3 - + 

Human echovirus 30 - + 

Human herpesvirus 1/2 (Herpes simplex virus 1/2) - + 

Human herpesvirus 3 (varicella-zoster virus) - + 

Human herpesvirus 5 (Cytomegalovirus) - + 

Enterovirus 71 - + 

Hepatitis A Virus - + 

Hepatitis B Virus - + 

Hepatitis C Virus - + 

Parvovirus B19 - + 

Listeria welshmerii - + 

Listeria ivanovii - + 

Mycobacterium tuberculosis - + 

Plasmodium falciparum - + 

 

11.3 Precision 

The precision data of the artus WNV TM RT-PCR Kit allow the determination 

of the total variance of the assay. The total variance consists of the 

intra-assay variability (variability of multiple results of samples of the same 

concentration within one experiment), the inter-assay variability (variability of 

multiple results of the assay generated on different instruments of the same 

type by different operators within one laboratory) and the 

inter-batch variability (variability of multiple results of the assay using 

various batches). The data obtained were used to determine the standard 
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deviation, the variance and the coefficient of variation for the pathogen 

specific and the Internal Control PCR. 

Precision data of the artus WNVTM RT-PCR Kit have been collected using the 

extracted and prequantified WNV RNA with the concentration of the lowest 

Quantitation Standard. (QS 4; 40 copies/µl). Testing was performed with eight 

replicates. The precision data were calculated on basis of the Ct values of the 

amplification curves (Ct: threshold cycle, see Table 2). In addition, precision 

data for quantitative results in copies/µl were determined using the 

corresponding Ct values (see Table 2). Based on these results, the overall 

statistical spread of any given sample with the mentioned concentration is 

1.53 % (Ct) or 17.18 % (conc.), for the detection of the Internal Control 

2.77 % (Ct). These values are based on the totality of all single values of the 

determined variabilities. 

Table 2: Precision data on basis of the Ct values. 

 Standard 
deviation Variance Coefficient of 

variation [%] 

Intra-assay variability: 
WNV RNA 1 x 104 copies/µl  

0.16 0.03 0.52 

Intra-assay variability: 
Internal Control 

0.15 0.02 0.56 

Inter-assay variability: 
WNV RNA 1 x 104 copies/µl 

0.14 0.02 0.46 

Inter-assay variability: 
Internal Control 

0.27 0.07 1.05 

Inter-batch variability: 
WNV RNA 1 x 104 copies/µl 

0.29 0.08 0.96 

Inter-batch variability: 
Internal Control 

0.54 0.32 2.18 

Total variance: 
WNV RNA 1 x 104 copies/µl 

0.46 0.21 1.53 

Total variance: 
Internal Control 

0.70 0.49 2.77 
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Table 3: Precision data on basis of the quantitative results (in copies/µl). 

 Standard 
deviation Variance Coefficient of 

variation [%] 

Intra-assay variability: 
WNV RNA 1 x 104 copies/µl 

4.18 17.44 10.39 

Inter-assay variability: 
WNV RNA 1 x 104 copies/µl 

4.16 17.33 10.57 

Inter-batch variability: 
WNV RNA 1 x 104 copies/µl 

9.17 84.13 23.89 

Total variance: 
WNV RNA 1 x 104 copies/µl 

6.71 45.07 17.18 

 

11.4 Robustness 

The verification of the robustness allows the determination of the total failure 

rate of the artus WNV TM RT-PCR Kit. 30 WNV negative samples of liquor 

and plasma were spiked with 1 copie/µl elution volume of WNV RNA (approx. 

threefold concentration of the analytical sensitivity limit). After extraction using 

the QIAamp Viral RNA Mini Kit (see 8.1 RNA Isolation) these samples were 

analysed with the artus WNV TM RT-PCR Kit. For all WNV samples the failure 

rate was 0 %. In addition, the robustness of the Internal Control was assessed 

by purification and analysis of 30 WNV negative liquor and plasma samples. 

The total failure rate was 0 %. Inhibitions were not observed. Thus, the 

robustness of the artus WNV TM RT-PCR Kits is ≥ 99 %. 

11.5 Reproducibility 

Reproducibility data permit a regular performance assessment of the 

artus WNV TM RT-PCR Kit as well as an efficiency comparison with other 

products. These data are obtained by the participation in established 

proficiency programmes. 

11.6 Diagnostic Evaluation 

Currently, the artus WNV TM RT-PCR Kit is undergoing a series of evaluation 

studies. 
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12. Product Use Limitations 

� The artus WNV TM RT-PCR Kit is for research use only. Not for use 

in diagnostic procedures. 

� No claim or representation is intended for their use for a specific 

clinical use (diagnostic, prognostic, or therapeutic). It is the user’s 

responsibility to validate the performance of the artus WNV TM 

RT-PCR Kit for any particular use. 

� Strict compliance with the user manual is required for optimal PCR 

results. 

� Attention should be paid to expiration dates printed on the box and 

labels of all components. Do not use expired components. 

13. Safety Information 

For safety information of the artus WNV TM RT-PCR Kit, please consult the 

appropriate material safety data sheet (MSDS). The MSDS are available 

online in convenient and compact PDF format at 

www.qiagen.com/support/msds.aspx. 

14. Quality Control 

In accordance with QIAGEN’s ISO 9001 and ISO 13485-certified Total Quality 

Management System, each lot of artus WNV TM RT-PCR Kit is tested against 

predetermined specifications to ensure consistent product quality. 

15. References 

Mackay IM. Real-time PCR in the microbiology laboratory. Clin. Microbiol. 

Infect. 2004; 10 (3): 190 - 212. 
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16. Explanation of Symbols 

 Use by 

 Batch code 

 Manufacturer 

 Catalogue number 

 Material number 

 Handbook 

 <N> Contains sufficient for <N> tests 

 Temperature limitation 

 Quantitation Standard 

 Internal Control 

 Magnesium Solution 
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